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Part 1. ZBM ZigBee 개발 키트 소개 
 

1) 제품 개요 

 

ZBM은 CC2420과 Atmega128L로 구성된 ZigBee 학습 및 개발용 H/W 플랫폼이다. 

CC2420은 TI사에서 공급하는  RF 트랜시버 칩으로서 IEEE 802.15.4 규격을 만족하

는 무선 송수신 기능을 제공한다. Atmega128L은 ATMEL사의 8bit RISC 마이콤으로

서 국내에서  다양하게 활용되고 있으며 사용자의 입장에서 다른 타입의 마이콤에 비해

상대적으로 접근이 용이하다고 할 수 있다. 

ZigBee 개발용 플랫폼은 현재 다양한 제품들이 나와 있지만 각기 사용되는 RF칩이 

상이하고 특히 마이콤이 임베디드 개발자에게 친숙하지 않은 제품들이 많다. 따라서 극

 소수의 전문적인 개발자가 아닌 일반 학생이나 초보자의 입장에서는 접근하기가 상당

히난해한 관계로 CC2420과 Atmega128L로 구성된 TI사의 CC2420DBK를 기초로 사

용자가 보다 쉽게 기술을 습득하고 개발할 수 있도록 ZBM을 제작하였다. 

 

Atmega128L

8-bit RISC 

MCU 

CC2420 

2.4GHz RF 

Transceiver 

8MHz

X-tal 

16MHz 

X-tal 

USB 

To 

Serial 

3.3V 

Regulator 

I/O

Battery 

USB 

(VCP) 

ZBM

UART SPI
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2) 제품 특징 

 

 − USB 포트를 상시리얼 접속 으로서 9핀 시리얼 없이 시리얼 통신 

 − 마이콤의 입출력 핀들을 커넥터를 통해 외부 회로와 접속 가능 

 G 포트를  프로그래밍

 − 고효율의 PC  안테나 

 − 전원아답타 없이 일반건전지 사용 

 

 통한 가  방식  포트 

− JTA  통한

B 내장

 

 

[전면] 
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[후면] 
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3) 제품 사양 
 

Absolute Maximum Ratings  

Parameter  Min. Max. Units  

Supply voltage  −0.3 7.5  V  

Input RF level    10 dBm 

Storage temperature range  −50  150  °C  

 

Operating Conditions  

Parameter  Min. Max. Units  

Supply voltage  4.8 7.5 V  

Operating ambient temperature range −30  85  °C  

 

Electrical Specifications  

Parameter  Min.  Typ. Max.  Units  

Overall  

RF Frequency Range   2483.5 MHz  2400  

Transmit Section  

Transmit bit rate  250    250  kbps  

Transmit chip rate  2000   2000  kChips/s 

Nominal output power  −3 0   dBm  

Programmable output power range   24  dB  

Receive Section  

Receiver Sensitivity  −90   −94   dBm  

Saturation (maximum input level)  0  10   dBm  

Frequency error tolerance  −300  300  kHz  

Symbol rate error tolerance    120 ppm 

RSSI / Carrier Sense  

Carrier sense level   −77  dBm  

RSSI dynamic range   100  dB  

RSSI accuracy   ± 6   dB  

RSSI linearity   ± 3   dB  

RSSI average time   128  µs  
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CC2420 Frequency  Section 

Crystal oscillator frequency   16   MHz  

Crystal frequency accuracy requirement  − 40      40 ppm

Atmega128L Frequency  Section 

Crystal oscillator frequency   8   Hz  M

Crystal frequency accuracy requirement  − 100  100  ppm  

Power Supply  

Current Consumption, transmit mode:   

 mA  P = 0 dBm  

 

46

  

Current Consumption, receive mode     49  mA  

 

Physical Properties  

Parameter  Min.  

Size 100 mm x 70 mm X 24mm (with battery holder) 

Weight 46 / 92 g (without/with battery) 
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E

 

xternal Pin Assignment  

Pin NO. Pin Name 

P1 (JTAG) 

1 TCK 

2 GND 

3 TDO 

4 3.3V 

5 TMS 

6 /RESET 

7 3.3V 

8 not connected 

9 TDI 

10 GND 

P2 (USB−UART) 

1 +5 (from PC) 

2 −DATA 

3 +DATA 

4 GND 

 

※ 주의 : 외부 확장 핀은 3.3V 입∙출력 전압 규격임. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pin NO. Pin Name 

P3 (ISP) 

1 PE0 

2 3.3V 

3 ot co nected n n

4 D GN

5 E  /RES T

6 GND 

7 SCLK 

8 GND 

9 PE1 

10 GND 
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Pin NO. Pin Name 

P4 (GPIO) 

1 PA1 

2 PA0 

3 PA3 

4 PA2 

5 PA5 

6 PA4 

7 PA7 

8 PA6 

9 PC1 

Pin NO. Pin Name 

P5 (GPIO) 

1 AREF 

2 PF0 

3 PF1 

4 PF2 

5 PF3 

6 PE0 

7 PE1 

8 PE2 

9 PE3 

10 PE4 

11 PE5 

12 PE6 

13 PE7 

14 PB4 

15 PB5 

10 PC0 

11 PC3 

12 PC2 

13 PC5 

14 PC4 

15 PC7 

16 PC6 

17 PG1 

18 PG0 

19 GND 

20 PG2 

16 PB6 

17 PB7 

18 not connected 

19 GND 

20 3.3V 

 

 

※ 주의 : 외부 확장 핀은 3.3V 입∙출력 전압 규격임. 
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Part 2. 프로그램 개발 환경 
 

ZBM  이용하여 프로그램을 개발하데 필요한  툴과  절차는 다음과 같다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 개발  개발을

WinAVR 설

AVR Studio 설치 

JTAG ICE 설치 

USB(VCP) Driv 치 er 설

 ZBM 설치 

예제프로그램 설치 및 실행 

사용자 프로그램 개발 

치 
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1) WinAVR 설치 

다음의  URL을 방문하여 설치파일을 다운로드하여 . 

▪  URL : http://sourceforge.net/project/showfiles.php?group_id=68108 

▪ 설치파일 : WinAVR−20060421−install.exe  

설치한다
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2) AV

다음의  URL을  설치한다. 

▪  URL : http://www.atmel.com 

▪  설치파일1 : AVR Studio 4.12 (build 460) (*간단한 등록 과정 필요) 

▪  설치파일2 : AVR Studio 4.12 Service Pack 4 (build 498)

R Studio 설치 

 방문하여 설치파일을 검색, 다운로드하여
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3) JT

사용자 별로 J

ZB

 

▪  Atmega128 지원 

▪  ATMEL 10핀 표준 포트를 제공 

▪   +3.3V 타겟보드와 접속  

 

4) USB(VCP) Driver 설치 

다음의  URL을 방문하여 윈도우 버전에 해당하는 설치파일을 다운로드하여 설치한다. 

▪  URL :  http://www.ftdichip.com/Drivers/VCP.htm 

▪  설치파일 : CDM_Setup.exe  

AG ICE 설치 

TAG ICE를 구비하여 설치한다. 

M 에 사용 가능한 JTAG ICE 의 요건은 다음과 같다. 
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5) ZBM 

▪  연결한다. 

▪  ZBM의 P2(USB포트)와 PC의 USB 컨넥터를 USB 케이블을 사용하여 연결한다. 

▪  ZBM의 전원 스위치를 ON한다. 

   ⇒ PC에서 자동으로 가상 시리얼 포트를 할당한다. 

       에서 포트 설정을 확인한다. 

설치 

  ZBM의 JTAG 포트에 JTAG ICE를

시작→제어판→시스템→하드웨어→장치관리자

 

ZBM 시리얼포트

JTAG ICE 포트
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▪  하이퍼터미널을 실행한다. 

(시작→모든프로그램→보조프로그램→통신/) 

▪  파일→새연결을 수행한다. 

  이름 : ex) ZBM monitor 

  연결에 사용할 모뎀 : COM3 (장치관리자에서 확인된 포트) 

  비트/초 : 115200 

  데이터 비트 : 8 

  패리티 : 없음 

  정지 비트 : 1 

  흐름 제어 : 없음 

▪  ZBM 의 리셋 버턴(S1)을 ON/OFF 하면 하이퍼터미널 화면에 ZBM 초기화면이 출력된다. 

▪  ’4’를 타이핑하여 ZBM 의 Address 세팅 값을 확인한다. 
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Part 3.  예제 프로그램 

 

1) 예제 프  

다

Bee 

▪ 압축파일 : ZBM10.zip

 

2) 예제 프로그램 실행 

▪ ‘Part 2. 프로그램 개발 환경’ 의 ’5) ZBM 설치’ 과정을 수행하여 ZBM과 JTAG ICE 및  

하이퍼터미널을 활성화 한다. 

▪ AVR Studio를 실행한다. 

▪ Project →Open Project 과정으로 압축 해제한 ZBM10 디렉토리 아래에 있는 

ZBM10.aps를 로드한다. 

▪ 프로그램을 수정한다. (필요한 경우) 

▪ File →Save All을 수행하여 작업한 파일을 저장한다. 

▪ Build →Build All을 수행하여 실행 파일을 생성한다. 

▪ Tools →Program AVR →Connect를 수행한다. 

  Platform : JTAG ICE 

  Port : COM5 (현재 JTAG ICE가 접속되어 있는 포트) 

lash 카테고리의 ‘Input HEX File’의 경로를 지정한다. 

 ZBM10/default/ZBM10.hex 

▪ 프로그래머 다이얼로그에서 Flash 카테고리의 ‘Program’ 버턴을 클릭하면 ZBM 내의 

 다운로드 된다. 

로그램 설치

음의  URL을 방문하여 압축파일을 다운로드하여 임의의 작업 디렉토리에 압축 해제한다. 

▪  URL : http://olmicrowaves.com  => Downloads => Zig

▪ 프로그래머 다이얼로그에서 F

 MCU로 펌웨어 프로그램이
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3) 예

예제  구성되어 있다. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

시킨다. 

(lib/basic_rf/*.c) 파일에 관련된 정의 

▪ hal.h : CC2420에 접근하기 위한 SPI 제어 매크로 정의 

▪ hal_cc2420db.h : CC2420과 MCU 주변 장치와의 접속을 정의 

제 프로그램 설명 

 프로젝트 디렉토리 ZBM10은 다음과 같은 파일과 하위 디렉토리로

ZBM10 apps 

 

▪ sensing.c : 응용프로그램으로서, main() 함수를 포함하는 기본 프로그램 

▪ ZBM10.hex : MCU 다운로드 파일 

▪ include.h : 기본적 데이터 타입이 정의되어 있고, 여러가지 헤드파일들을 include 

▪ basic_rf.h : basic rf library

▪ hal_cc2420.h : CC2420에 관련된 정의 

ZBM10.aps 

default 

include 

lib 

sensing.c 

BM10.hex,  오브젝트 파일 Z

basic_rf 

hal 

basic_rf 

include.h 

basic_rf.h 

atmega128

hal_cc2420.h 

hal.h 

hal_cc2420db.h 

hal 

basic_rf_init.c 

basic_rf_receive.c 

basic_rf_send_packet.c 

hal_rf_set_channel.c 

tal_oscillator.c 

atmega128 hal_wait.c 

hal_rf_wait_for_crys
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▪ basic_rf_init.c : CC2420의 무선 송신 및 수신 동작을 위한 초기화 

▪ basic_rf_receive.c : 무선 패킷을 수신하기 위한 인터럽트 서비스 루틴 

▪ basic_rf_send_packet.c : 무선 패킷을 송신하기 위한 루틴 

▪ hal_wait.c : Delay 함수 

▪ hal_rf_set_channel.c : 주어진 채널번호로부터 IEEE802.15.4 무선 주파수 설정 

▪ hal_rf_wait_for_crystal_oscillator.c : CC2420 내부 오실레이터의 안정화까지 대기 

▪ ZBM10.aps : AVR Studio 프로젝트 파일 

 

 ZBM 예제 프로젝트(ZBM10)은 TI사의 CC2420DBK 예제 프로그램을 기초로 작성되었다. 

TI사의 원본을 다운로드하려면 다음의 URL을 방문하여 압축파일을 다운로드한다. 

▪  URL : http://focus.ti.com/docs/toolsw/folders/print/cc2420dbk.html 

▪ 압축파일 : CC2420DBK Libraries (swrc024.zip, 22 KB) 

CC2420DBK Examples Release (swrc023.zip, 12 KB) 

 

※

(A

 

        #include <string.h>  

 

        #de

  

        #ifd

            #

        #endif  

 

        #ifd

            #include "include/hal/atmega128/hal_cc2420db.h"  

        #en

 

※

 

 TI 원본에서 ZBM10이 수정된 부분 

) ZBM10 / include / include.h 수정  

... 

fine CC2420DB  

ef STK501  

include "include/hal/atmega128/hal_stk501.h"  

ef CC2420DB  

dif  
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        // H

        #include "include/hal/atmega128/hal.h"  

        #inc

 

        // BASIC RF include files  

        #inc de "include/basic_rf/basic_rf.h"  

 

(B) 아래의 각 소스파일에서 include 경로 수정 : #include "include\include.h"  

 

zbm / lib / basic_rf / basic_rf_receive.c  

zbm 

         zbm / lib / hal / hal_rf_wait_for_crystal_oscillator.c  

         zbm / lib / hal / atmega128 / hal_wait.c  

       _led / rf_blink_led.c  

 

(C) hal_cc2420db.h 수정 사항  

 

< AVR과 CC2420 간의 핀 설정 비교> 

 

 

 

     

 

 

 

 

 

 

 

 

 

 

 

 

ame CC2420DBK ZBM 

AL include files  

lude "include/hal/hal_cc2420.h"  

lu

zbm / lib / basic_rf / basic_rf_init.c              

zbm / lib / basic_rf / basic_rf_send_packet.c  

/ lib / hal / hal_rf_set_channel.c  

 zbm / apps / basic_rf / rf_blink

Signal N

CSN PB0 " 

SCLK PB1 " 

SI PB2 " 

SO PB3 " 

VREG_EN PB5 PG3 

RESETN PB6 PG4 

CTS PD7 " 

CCA PD6 " 

RTS PD5 " 

SFD PD4 " 

TXD1 PD3 " 

RXD1 PD2 " 

FIFO PD1 " 

FIFOP PD0 " 

19 / 31 



 

// Port B  

#defin

define SCK             1  // PB.1 − Output: SPI Serial Clock (SCLK)  

#define MOSI       e in (MOSI)  

#define MISO       ve out (MISO)  

#define OLED     

//#define VREG_E  to CC2420  

ine ESET_

e G ED     

 Port G  

//−−−−−− −−−−−−−−  

define VREG_EN        3  // PG.3 − Output: VREG_EN to CC2420  

#define RESET_N   C2420  

 Port initialization  

 Disables pull−up on all inputs!!!  

fine PORT_INIT() \  

  do { \  

      SFIOR |= BM(PUD); \  

      DDRB  = BM | BM(CS M(OLED) | BM(GLED); \  

      PORTB = BM M(S  | BM(CS

      DDRD  = BM(U T1_RTS)

      PORTD = BM(UART1_RTS 1 CTS);\  

      DDRE  = BM(R | BM(YLED); \  

      PORTE = 0x00; \  

      DDRG  = BM T_N) | EG_EN  \  

      PORTG = BM T_N);

  } while (0)  

 pin access  

e CSN             0  // PB.0 − Output: SPI Chip Select (CS_N)  

#

      2  // PB.2 − Output: SPI Master out − slav

      3  // PB.3 − Input:  SPI Master in − sla

       4  // PB.4 − Output: Orange LED  

N         5  // PB.5 − Output: VREG_EN

//#def  R N         6  // PB.6 − Output: RESET_N to CC2420  

#defin L        7  // PB.7 − Output: Green LED  

 

//

−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

#

       4  // PG.4 − Output: RESET_N to C

 

//

//

#de

  

  

   (MOSI) | BM(SCK) N) | B

   (MOSI) | B CK) N); \  

   AR ; \  

   ) | BM(UART _

   LED) 

  

   (RESE BM(VR );

   (RESE  \  

  

 

// CC2420

 

// Pin status  

#define FIFO_IS_1       (!!(PIND & BM(FIFO)))  

#define CCA_IS_1        (!!(PIND & BM(CCA)))  

#define RESET_IS_1      (!!(PING & BM(RESET_N)))  
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#define VREG_IS_1       (!!(PING & BM(VREG_EN)))  

#define FIFOP_IS_1      (!!(PIND & BM(FIFOP)))  

#define SFD_IS_1        (!!(PIND & BM(SFD)))  

 

// The CC2420 reset pin  

M(RESET_N)  

 CC2420 voltage regulator enable pin  

_ACTIVE()     PORTG |= BM(VREG_EN)  

 PORTG &= ~BM(VREG_EN)  

 hal.h UART 관련 오류 수정  

T1_RECEIVE(x); } while (0)  

 추가 및 수정  

SR1A & BM(UDRE1))); CLEAR_UART1_TX_INT(); } while (0)  

IT()  do { while (!(UCSR1A & BM(RXC1))); CLEAR_UART1_RX_INT(); } while (0)  

(x)     do { UART1_WAIT(); UART1_SEND(x); } while (0)  

1_RECEIVE(x)             do { (x) = UDR1; } while (0)  

define UART1_WAIT_AND_RECEIVE(x) do {UDR1=0; UART1_RXWAIT(); UART1_RECEIVE(x); } while(0) 

EED() do { UART1_WAIT_AND_SEND(13); UART1_WAIT_AND_SEND(10); }while(0)  

#define SET_RESET_ACTIVE()    PORTG &= ~B

#define SET_RESET_INACTIVE()  PORTG |= BM(RESET_N)  

 

//

#define SET_VREG

#define SET_VREG_INACTIVE()  

 

(D)

 

#define UART1_WAIT_AND_RECEIVE(x) do{ UDR1 = 0; UART1_WAIT(); UAR

 

(E) hal.h  UART 관련 매크로

 

#define UART1_WAIT()     do { while (!(UC

#define UART1_RXWA

#define UART1_SEND(x)   do { UDR1 = (x); } while (0)  

#define UART1_WAIT_AND_SEND

#define UART

#

#define UART1_LINEF
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4)  사용자 프로그램 개발 

로 사용될 수 있으며 뿐만 아니라 

외부 확장용 컨넥터(P4, P5)를 통해 각종 센서나 제어기와 접속하여 ZigBee 응용시스템을  

개발하는 용도로 활용할 수 있다.  

지 8 ~ 9 참조) 

▪ P4 : 범용I/O 및 메모리 제어 신호 

입출력으로 외부 장치와 접속 

 

■  ZBM은 ZigBee 프로토콜을 개발하거나 학습하는 용도

■  사용자별로 응용프로그램 개발하기 위해서 외부 확장 커넥터별 신호 구성을 파악한 후  

별도의 도터보드를 제작하여 장착한다. (페이

       − 외부 메모리를 확장하거나 일반 범용 입출력으로 외부 장치와 접속 

▪ P5 : ADC, 아나로그 입력, 인터럽트, 범용I/O 

       − 센서 장치나 제어 장치와 접속하거나  일반 범용 

     (예: 조명제어 응용 실습) 
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■

, AVR Studio(WinAVR/avr−gcc)나  IAR 컴파일러 등을 

  

표준 스택을 제공하며 다음의 URL을 방문하여  

ent.tsp?familyId=367&genContentId=31010 

  MAC프로그램이나 ZigBee 스택을 포팅하고자 하는 경우에는 각 프로그램의 HAL 부분을  

Atmega128에 적합하게 구성한 후

이용하여 컴파일하고, 생성된 hex 파일을  AVR Studio나 PonyProg를 사용하여 ZBM의

Flash ROM에 다운로드 한다. 

TI사에서는 Z−stack이라는 ZigBee 

무료로 다운로드하여 사용할 수 있다. (간단한 사용자 등록 필요) 

▪  URL : http://focus.ti.com/analog/docs/gencont
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Part

ZB

ZBM10에는 두 개의 ZBM을 하나는 마스터로 다른 하나는 센서로 간주하고 각각의 

Address를 설정하여(디폴트로: 00, 99) 터미널(PC)로부터 마스터를 경유하여 무선 

으로 센서를 제어하는 동작이 구현되어 있다.  

이 예제를 통해 MCU를 사용하여 ZigBee용 RF 트랜시버 칩인 CC2420을 제어하는  

방법을 습득할  수 있으며 ZBM을 홈네트워크나 기타 다양한 분야에 활용할 수 있도록 

기본적인 아이디어를 제공한다. 

 

▪  마스터로 사용할 ZBM을 `Part 2. 프로그램 개발 환경’ 의 ’5) ZBM 설치’ 과정 수행하여 

셋업한다. 

▪  리셋 버턴을 누르면 하이퍼터미널 상에 초기 화면이 출력된다. 

 4.  ZBM 실습 

M에 다운로드 되어 있는 프로그램은 예제 프로젝트인 ZBM10이다. 
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▪  `4’를 입력하여 현재 ZBM에 설정된 Address를 확인한다. 

 

▪  필요한 경우 `5’를 입력하여 Address를 다른 값으로 변경한다.(00 ~ 99 사이의 값) 
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▪  동일한 방식으로 센서로 사용할 ZBM의 Address도 확인하고 필요하면 Addres를 변경 

한다. 

▪  터미널(PC)에 다시 마스터 ZBM을 접속하고, 센서 ZBM을 3미터 정도의 거리에 설치한다. 

▪  하이퍼터미널로 `1’과 ’99’를 차례로 입력하여 Address가 99인 센서 ZBM의 RSSI 값을 

읽는다. (센서 Address는 사용자별로 설정한 값을 입력) 

 

 이 때, 출력되는 RSSI 값은 센서가 마스터로부터 수신하는 신호의 세기를 나타내며, 

 ZBM의 안테나 출력 전력은 약 0dBm(디폴트)으로 설정되어 있다. 따라서  

 하이퍼터미널 상에 출력되는 RSSI 값은 수신 전력 값인 동시에 해당 거리에서의  

 경로손실(Path Loss)라고 할 수 있다. 이러한 사실로부터 사용자는 RSSI 관련한  

 다양한 응용을 할 수 있다. 마스터가 센서로부터 수신하는 신호의 세기도 동일한  

 값으로 간주해도 된다. 
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▪  ZBM  monitor의 ’2’과 ’3’ 명령은 조도센서 값을 읽고, LED를 켜거나 끄는 동작을 수행 

 9등), LED, 저항(180~200Ω), 

             가변저항(100KΩ), 핀헤드(2x10), 납땜용구(인두기, 납) 

 ◆ 도터보드 회로도 

한다.  그러나 조도센서와 LED 회로는 ZBM 모듈에 포함되지 않느다. 따라서 사용자는  

다음의 과정을 따라 도터보드를 제작하여 실습을 수행하도록 한다. 

◆  준비물 : 만능기판(HS−01 혹은 기타), 조도센서(A90.0

 

 

 

    

  

 

 

 

 

◆  만능기판을 적당한 크기로 자른다. (3 cm x 3.5 cm 가량) 

  ◆  기판에 회로도를 참조하여 부품을 배치한 후 납땜한다. 

− 핀헤드(P5)는 센서 ZBM의 소켓(P5)에 장착될 수 있도록 한다. 
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 [전면]                                                      [후면] 

 

▪  제작한 도터보드를 센서 ZBM 의 소켓(P5)에 장착한다. (방향에 유의) 
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▪  하이퍼터미널로 `2’와 ’99’를 차례로 입력하여 Address가 99인 센서 ZBM의 조도값을 

읽는다. (센서 Address는 사용자별로 설정한 값을 입력) 

 

 

 

 조도값의 범위는 0 ~ 255이며 A/D 컨버터에서 읽은 값을 8비트 처리하여 출력한다. 

 가변저항을 조절하면 특정한 조도에 출력값을 튜닝할 수 있다. 
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▪  가 99인 센서 ZBM의 LED를 

. 

 

하이퍼터미널로 `3’,  ’99’, ’1’을 차례로 입력하여 Address

 켠다

 

 

센서 ZBM의 LED의 상태를 확인한다.  
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▪  미널로 `3’,  ’99’, ’0’을 차례로 입력하여 Address가 99인 센서 ZBM의 LED를 

. 

 

하이퍼터

 끈다

 

 

센서 ZBM의 LED의 상태를 확인한다.  
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